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The Apalachicola River has the greatest discharge of any river in the State of Florida, and 

has one of the largest forested floodplains of any river in the southeastern US.  Rapid 

urbanization of the upper ACF basin, as well as several extensive droughts in the region have 

resulted in increased demands for water withdrawals and flow regulation for municipal, 

commercial, and agricultural uses throughout the basin.  This has positioned the states of Florida, 

Georgia, and Alabama, along with several federal agencies, in a surface water allocation and 

management conflict.  Of particular concern are minimum flows and levels required to maintain 

healthy biotic communities during periods of regional drought, when water demands are at their 

highest, and the resource is most limited. 

Very low flows confine the primarily sandy-bottomed Apalachicola River to its main 

channel, where snags serve as the only stable structural habitat for the riverine fauna.  This study 

aimed to assess the ecological importance, and quantify the amount of snags submerged in the 

Apalachicola River as a result of variations in flow regime.  Additionally, the distributions of 

snags based on river-bank habitat and geomorphological characteristics were also examined to 

assess their role in snag habitat availability.  Traditional aquatic snag quantification methods 
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were not feasible in the exceedingly turbid, high-order Coastal Plain river; therefore, a novel 

method using digital imaging analysis techniques was developed for analysis. 

Area and percentage of available snag habitat submerged were analyzed at 0.5-m 

elevations above water level for 60 sampling stations along the Apalachicola River at a 

relatively-low river discharge.  Snag area values generated using the novel methods presented in 

this study were credible for steep sloping bank, gentle sloping bank and dike field habitat types, 

but were erroneously-elevated for sandbar stations.  Snag quantities of non-sandbar stations were 

found to be greatest within the first 1.0 m of exposed bank for nearly all sites surveyed, while 

steep sloping banks typically exhibited the most uniform vertical snag distribution.  In most 

cases, geomorphic classifications demonstrated no considerable effect on non-sandbar habitat 

snag distribution; however, the outer banks of river bends exhibited a more balanced vertical 

distribution of snags than inner banks of river bends or along the banks of river straightaways.  

Limitations and proposed modifications to the digital imaging methods are discussed, and 

recommendations are provided in support of increased water flows for ecological sustainability 

in the Apalachicola River. 
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CHAPTER 1 
INTRODUCTION AND OBJECTIVES 

The Apalachicola River is the State of Florida’s largest river by discharge, and has one of 

the most extensively forested floodplains of any river in the southeastern Coastal Plain.  Home to 

a diverse fauna, including many threatened and endangered species, the basin is a significant 

natural resource worthy of conservation efforts.  The Apalachicola River and Bay system is 

remarkable in that it has remained relatively intact as urbanization has transformed comparable 

riverine systems within North America.  Therefore, conservation and rehabilitation efforts that 

are enacted in the Apalachicola River are currently proactive, rather than reactive; consequently, 

such efforts tend to be less expensive and have an increased likelihood of success over time.  In 

light of several major droughts, concerns have arisen over declining water availability in the 

river, as well as decreasing freshwater inputs into the Apalachicola Bay estuary, due to rapid 

population growth and accelerated water consumption throughout the greater ACF basin.  

Regulated flows and competing water withdrawals have generated disputes over states’ water 

rights, as well as management of federal reservoirs within the region.  This has positioned the 

states of Florida, Georgia, and Alabama in a water allocation conflict, the eventual consequences 

of which may jeopardize biological communities that are dependent on the annual flow cycles of 

the rivers.  Of particular concern are low-flow conditions and habitat availability during critical 

phases in the ecology of river-dependent biota. 

Numerous local, state, and federal agencies are responsible for management and 

optimization of water resources within the 50,764-km2 ACF basin; consequently, water-

allocation disputes within the region have been contentious.  As the metropolitan Atlanta area 

continues to grow and water demands multiply, Georgia-based interest groups have endeavored 

to store as much surface water as possible in upstream Chattahoochee River reservoirs.  
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Maintaining equity of water use among consumers in the upper reaches of the ACF basin with 

the ecological needs and consumptive use requirements of downstream users has been 

challenging.  Determining the quantities of reasonable and beneficial river water use varies 

greatly among stakeholders depending upon their location within the ACF basin.  In watersheds 

throughout the world, water managers are beginning to implement adaptive management 

techniques to resolve conflicts similar to those exhibited in the ACF basin.  Successful adaptive 

management is achieved by collecting baseline data of critical components, monitoring 

deviations over time, and making sensible modifications to management plans as environmental 

conditions change (Richter et al. 2003).  The monitoring and documentation of rehabilitation 

efforts in fluvial systems is critical to the success of adaptive management strategies (Bash and 

Ryan 2002). 

With habitat loss considered a primary threat to imperiled species, critical habitats within 

fluvial ecosystems have been targeted as goals for conservation.  In the context of rivers, snags 

are defined as any woody structures, regardless of size, located within the banks of a 

watercourse.  During low water flows, the primarily sandy-bottomed Apalachicola River 

becomes almost completely confined to its main channel, and as a result, snags provide the only 

stable structural habitat and cover available for its river-based fauna.  For years, aquatic 

ecologists have recognized the importance of snag habitat in maintaining productive ecosystems.  

However, it was not until fairly recently that focused efforts were made to quantify riverine snag 

habitat.  Due to the dynamic nature of a river system, it is difficult to predict rates of wood input 

and depletion as they vary over space and time.  Wallace and Benke (1984) stated that the 

quantification of riverine wood habitat is essential in assessing past or potential impacts of snag 

removal on ecosystem processes.  Furthermore, determining the amount of available snag 
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material and its ecological role is vital in understanding how anthropogenic alterations to fluvial 

systems influence ecosystem success and dynamics.  In Florida, very little research has been 

performed that quantifies the loss of habitat for aquatic fauna when snag material is removed 

from the system, or when woody material is exposed during decreasing river discharges.  As 

minimum flows and levels are discussed within the management of the ACF basin, it is 

imperative to know how changes in flow affect snag habitat availability.  Scientists in various 

disciplines have been requested to collect data and provide input to assist officials in making 

informed decisions concerning the regulation and management of water resources within the 

ACF basin.  This study endeavored to provide insight into the quantity of aquatic snags 

submerged in the Apalachicola River at various flow regimes using a novel digital imaging 

analysis technique.  In addition, the distribution of snags based on river bank habitat and 

geomorphological characteristics was also examined to indicate their prospective influence on 

snag habitat availability within the Apalachicola River. 
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CHAPTER 2 
APALACHICOLA RIVER, ACF BASIN, AND THE TRI-STATE WATER CONFLICT 

Apalachicola River and ACF Basin 

Two large rivers in the southeastern US, the Chattahoochee and the Flint, converge to form 

Lake Seminole, a shallow 152-km2 man-made reservoir in southeastern Georgia (Figure 2-1).  

The Apalachicola River headwaters are created by the tailwater discharge of Lake Seminole at 

the Jim Woodruff Lock and Dam; a USACE operated navigation and hydroelectric generation 

facility that was completed in 1954.  The 805-km long ACF river system drains 50,764 km2 in 

the states of Florida, Georgia and Alabama, with approximately 13% of the total ACF basin 

contained within the State of Florida (Light et al. 2006). 

The Apalachicola River is the largest river in terms of mean annual discharge in Florida, 

and has the fourth largest discharge of rivers in the southeastern US (Leitman et al. 1991).  

Located in the Florida panhandle, the Apalachicola River basin drains 6,216 km2 of land within 

the state, of which about half is drained by the spring-fed Chipola River, its largest tributary 

(Leitman et al. 1983).  The Apalachicola River is a moderately sinuous, highly turbid, alluvial 

bed Coastal Plain river that flows 171 km from the Florida-Georgia state line to Apalachicola 

Bay (Light et al. 1998).  The river has a relief of 12.5 m from its headwaters at the Jim Woodruff 

Lock and Dam to its convergence with the Gulf of Mexico; relatively low for a river of its length 

(Meeter et al. 1979).  Light et al. (2006) reported that the average Apalachicola River discharge 

from 1929-2004 at the USGS gage near Chattahoochee, Florida was 21,900 cfs; however, flows 

were greatly influenced by upstream water management practices in the states of Alabama and 

Georgia, as well as seasonal variations in precipitation.  The lowest daily discharge at the 

Apalachicola River, Chattahoochee gage was 3,900 cfs during a severe drought in November 

1987; the highest recorded flow was 291,000 cfs, which occurred during a historic flood in 
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March 1929 (Light et al. 2006).  Average annual precipitation in the Apalachicola River basin is 

1.42 m, with the driest period typically occurring in the months from September through 

November (Leitman et al. 1991). 

Unlike most large-river basins of the southeastern US, the floodplain of the Apalachicola 

River lacks a major urban center, and is consequently sparsely populated.  Land uses along the 

river are primarily forestry or conservation lands, which contributes to the scarcity of 

development in the region (Leitman et al. 1991).  Additional factors contributing to the rural 

nature of the Apalachicola River basin include the relatively depressed economic status of the 

area, and limited ability for cross-river transportation and exchange of goods, as only four 

highway bridges traverse the river along its 171-km length. 

The extensive 454-km2 Apalachicola River floodplain is the largest of all rivers in Florida, 

and is abundantly forested by many species of cypress, tupelo, and other mixed-bottomland 

hardwood tree species, of which most have been logged several times since the year 1870 

(Leitman et al. 1983; Elder et al. 1988).  The ample forests of the Apalachicola River floodplain 

deposit approximately 3.6 x 105 metric tons of organic material onto the floodplain annually 

(Elder and Cairns 1982).  With one of the highest computed litter fall rates of any temperate 

forest, the Apalachicola River ecosystem is reliant on seasonal floods to mobilize, distribute, and 

recycle the large quantities of organic material and nutrients that accumulate on its floodplain. 

The habitats in and along the Apalachicola River basin contain one of the most species-rich 

assemblages of flora and fauna in the southeastern US (Livingston 1984; Leitman et al. 1991; 

Mitsch and Gosselink 2000).  An estimated 1,500 plant species, 450 vertebrate species, and a 

myriad of invertebrate taxa, including the largest number of freshwater mollusk species in the 

US, inhabit the Apalachicola River watershed (Heard 1977; Means 1977; Leitman 1984).  
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Additionally, many endemic and federally listed endangered or threatened species are found in 

the basin, making it one of the most significant ecosystems remaining in the US (Myers and 

Ewel 1990). 

Water Use Within the ACF Basin 

Both surface and groundwater resources are used by consumers within the ACF basin.  

Surface water is used for domestic and commercial supply, cooling of power plants, hydropower 

generation, transportation, irrigation, and recreation.  The largest urban center in the basin, the 

greater Atlanta metropolitan area, draws nearly all of its water supply from the upper reaches of 

the Chattahoochee River at Lake Lanier, with a portion of the water returning to the basin as 

treated wastewater.  As the city of Atlanta continues to grow, most models indicate that another 

source of water will need to be tapped in the near future, or extreme conservation efforts will 

need to be enacted in order to maintain the existing growth rate of the urban area.  The Georgia 

DEP asserts that its projections for future water supply, relying on the Chattahoochee River as a 

primary water source, are still sound, while the USACE indicates that the city has already 

exploited surface water quantities that equal, or at times have exceeded projections established 

for the year 2030 (Seabrook 2002).  Discussions of alternative water sources for the Atlanta 

metropolitan area have included the proposed construction of several water retention reservoirs 

on the upper Flint River, as well as the possibility of interbasin water transfers from the ACT, or 

Tennessee River watersheds (Hoehn 2001).  These alternatives have failed to materialize due to 

intense objections from a variety of political, environmental, and economic interests. 

Groundwater resources in the ACF basin are primarily used for self-supply domestic 

drinking wells, industrial and commercial applications, and for center-pivot irrigation of 

agriculture.  Large quantities of land in rural southwest Georgia are cultivated for ornamental, 

vegetable, fruit and nut, forage, and row-crop agriculture.  These large farms are dependent on 
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groundwater from the Chattahoochee and Flint river watersheds for irrigation, and ultimately for 

economic subsistence.  In addition, portions of the extensive Floridan Aquifer are recharged 

within the ACF basin, therefore intimately linking surface and groundwater systems (Elder et al. 

1988). 

Modifications Within the ACF Basin 

Over the past 200 years, various navigational enhancements have been made in the ACF 

basin to facilitate the movement of commodities on the river.  In the 1820’s, the first steamboats 

began to transport row crops such as corn, cotton, peanuts, and soybeans from cities in Alabama 

and Georgia to the seaport of Apalachicola, Florida (Kirkland 2001).  Mueller (1990) indicates 

that these early steamers would often encounter sections of the rivers where trees and snags 

traversed the entire waterway and would have to be displaced to allow boat passage.  From 1875 

to 1998, selective de-snagging operations in the Apalachicola and lower Chattahoochee rivers 

had removed approximately 334,000 woody obstructions including snags, stumps, bushes, 

overhanging trees, and drift logs (T. Hoehn, FFWCC, and S. Leitman, NWFWMD, unpublished 

data).  Ager et al. (1985) indicated that snag removal associated with navigational improvements 

has left much of the main channel Apalachicola River with a rather unproductive sandy bottom 

devoid of critical habitat.  Since 1956, when selective desnagging was most prevalent, the main 

channel of the Apalachicola River has actually become shallower and wider, due in part to 

removal of riparian snags (H. Light, USGS Tallahassee, personal communication).  A total of 16 

dams and associated reservoirs (13 on the Chattahoochee River; 3 on the Flint River) have been 

constructed and maintained upstream of the Apalachicola River for water storage, recreation, 

flood mitigation, navigation, and hydroelectricity generation (Ager et al. 1985).  In 1946, as part 

of the River and Harbors Act of the previous year, the US Congress authorized the USACE 

Mobile District to dredge and de-snag a 2.75-m x 30.5-m navigation channel through a large 
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portion of the ACF basin to encourage economic development and promote interstate commerce 

(Leitman 2005).  The constructed navigation channel traversed the entire length of the 

Apalachicola River, and extended up to Columbus, Georgia and Phoenix City, Alabama on the 

Chattahoochee River, and Bainbridge, Georgia on the Flint River.  A plethora of problems 

emerged following the completion of the watercourse, but the disposal of large quantities of 

dredge spoil at unprotected floodplain easement sites within the banks of the rivers, and the 

inability to maintain a mandated 2.75-m depth for barge traffic 95% of the year were critical 

shortfalls revealed over time (Leitman et al. 1991).  During the years of operation and 

maintenance of navigational conditions within the ACF basin, the quantity of barge traffic failed 

to meet the utility in which it had been designed and constructed, due primarily to 

inconsistencies in channel reliability.  Consequently, the majority of freight (sand, gravel, 

petroleum, and fertilizer) that was routinely transported by barges in other areas of the US 

ultimately was transported by truck or rail within the ACF basin.  Leitman et al. (1991) indicated 

that in the late 1980’s, the unit cost of maintaining the ACF waterway per ton-mile of freight 

shipped was the highest of any waterway in the US, and more than 40 times the national average.  

In 2003, nine barges used the ACF waterway to transport freight, while it was estimated that 

US$6.5 million dollars in tax revenue was spent to maintain the channel (Leitman 2005).  

Navigational channel maintenance in the Apalachicola River was carried out by the USACE 

until 2005, when the Florida DEP utilized its authority under the Clean Water Act to rescind the 

annual river dredging permit. 

In addition to the extensive dredging and de-snagging operations implemented to facilitate 

river transportation, another modification called ‘navigation windows’ were used on the 

Apalachicola River beginning in the year 1990.  During a navigation window, the USACE would 
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intermittently discharge large quantities of water from upstream reservoirs for a temporary ten-

day, to two-week period to allow scheduled barge traffic movement during low-water conditions 

(Leitman et al. 1991).  Navigation windows unfortunately altered the natural chemical, physical, 

and biological components of the floodplain habitat and its ecology during what were normally 

low-flow river conditions.  Another issue with navigation windows was the dramatic vertical 

drop in river stage over a short period of time, or ‘fall rate’, which would occur at the end of a 

scheduled navigation window.  This was particularly evident in April 2000, when a navigation 

window decimated fish populations in the Apalachicola River by stranding millions of 

reproducing fish and invertebrates in desiccating pools on the floodplain (Hoehn 2001).  In 

addition, residents with property on upstream reservoirs, especially those on Lake Lanier, 

objected to navigation windows that visibly lowered water levels, consequently leaving their 

recreational docks high and dry.  The practice of navigation windows was effectively 

discontinued with the revocation of the Florida DEP dredging permit in 2005, and the cessation 

of commercial navigation. 

Other Apalachicola River modifications implemented for enhanced water conveyance and 

improved river transportation included: 1) the creation of several bend easings and meander 

cutoffs to straighten navigationally difficult natural bends in the river; 2) the relocation and 

removal of rocky shoals in portions of the upper river; 3) the periodic release of water stores for 

flood control and reservoir management; and 4) the installation of river-training dikes to 

augment channel bed scour and increase downstream sediment transport (Leitman et al. 1991; 

Light et al. 1998). 

Tri-State ‘Water Wars’ Conflict 

As the human population continues to grow, there are increased demands for natural 

resources with limited availability.  One of the greatest public concerns is the accessibility to 
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freshwater resources, particularly in areas that have already exceeded their capacity to support 

growth.  Officials at multiple levels of government have been assigned the task of maintaining 

adequate water stores for natural and consumptive uses, as well as planning for future water 

demands.  Due to precipitation generated by the warm moist air from the Gulf of Mexico and 

Atlantic Ocean, southeastern US states have historically had sufficient water resources to meet 

the requirements of their growing populations (Leitman et al. 1991).  However, concerns have 

arisen recently in regards to adequate freshwater availability during seasonal droughts, and as 

rates of urbanization continue to increase throughout the region.  Two substantial droughts 

occurred in the southeastern US during the 1980’s that generated significant consideration to the 

limits of water availability in the ACF basin, and triggered the states to become increasingly 

acrimonious in regards to their water resources.  This has placed the states of Alabama, Georgia, 

and Florida in a surface water allocation conflict, the eventual consequences of which may 

jeopardize the ecology of the biota in the ACF basin, as well as in the extensive Apalachicola 

Bay estuary. 

In the US, the states have the authority to regulate the use of freshwater within their 

borders, with the exception of waterways used for navigation, and federally constructed 

reservoirs.  Each state has established its own water laws and mechanisms for modification of 

water regulations; however, congressional approval is required for any change in interstate water 

resource allocation.  When the US Congress authorized the development of the ACF waterway 

for navigation, hydropower, and flood control in 1946, they fundamentally removed state control 

of surface water in the basin in favor of federal management.  As with any water allocation and 

management decision in the US, an array of federal laws and regulations must be adhered to by 

the states.  While not entirely comprehensive, some of the principal legislative acts pertinent to 
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water management in the ACF basin include: the Rivers and Harbors Acts of 1945 and 1946, the 

Rivers and Harbors Flood Control Act of 1944, 1958, and 1962, the Water Resources Act, the 

Federal Power Act, the Clean Water Act, the Water Quality Control Act, the National 

Environmental Policy Act, the Endangered Species Act, the Migratory Bird Treaty Act, the 

Marine Mammal Protection Act, the Fish and Wildlife Coordination Act, and the Coastal Zone 

Management Act (Sherk 2005). 

The ACF basin is one of the largest freshwater contributors into the Gulf of Mexico 

(Livingston 1984).  The inputs from the Apalachicola River into Apalachicola Bay deliver 

significant quantities of valuable detritus and nutrients, as well as beneficially reduce the salinity 

of the estuary, therefore furnishing an ideal environment for shellfish, shrimp, and crabs.  Inputs 

from the river also control the distribution of essential estuarine habitats including seagrass beds, 

mangrove stands, tidal marshes, and mud flats necessary for productive estuaries (Myers and 

Ewel 1990).  Coastal cities in Franklin and Gulf counties near the mouth of the Apalachicola 

River rely heavily on the commercial fisheries of Apalachicola Bay for their existence and 

livelihood.  Apalachicola Bay, a 549-km2 lagoon-and-barrier island complex, is regarded as one 

of the most productive and least polluted estuaries in the US, and generates approximately 90% 

of Florida’s oysters, making up about 10% of the United States’ annual harvest (Livingston 

1984; Ruhl 2005; Wang et al. 2008).  The salinity pulse generated by the seasonal variation in 

river flows is critical to the health of oyster populations in the bay (Livingston et al. 2000).  In 

addition, Apalachicola Bay serves as an important nursery area for many marine species, and 

produces Florida’s third largest shrimp fishery, as well as a robust blue crab fishery (Oesterling 

and Evink 1977).  The Apalachicola Bay estuary has been recognized as a water body worthy of 

special protection, and is therefore designated as a UNESCO ‘International Biosphere Reserve’, 
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a NOAA ‘National Estuarine Research Reserve’, a Florida DEP ‘Aquatic Preserve’ and 

‘Outstanding Florida Water’. 

Analysis of time spent participating in outdoor activities within the US revealed that 

Florida trailed only Texas in time devoted to wildlife-related recreation (Struhs and Mainella, 

2000).  A report by Southwick and Allen (2003) indicated that in 2001, over 40% of Floridians 

participated in wildlife-related activities, and in addition, over 800,000 visitors came to the state 

specifically to partake in wildlife related recreation.  The Apalachicola River basin is of 

tremendous economic importance to Florida, and its floodplain and environs provide abundant 

opportunity for outdoor recreational activities such as fishing, hunting, camping, and hiking.  

The FFWCC (2008) boasts the state as being the ‘Fishing Capital of the World’, emphasizing the 

values of both recreational and commercial fishing to the state economy.  A combined report by 

the USFWS and USCB (2002) estimated that in 2001, freshwater fishing in Florida generated 

US$1.057 billion in retail sales alone.  Decreased water flow in the Apalachicola River severely 

affects fisheries in the river, as well as in Apalachicola Bay, two highly significant economic 

contributions to the State of Florida. 

With multiple authorities having control of water resources in the ACF basin, the states of 

Alabama and Florida along with the USACE quarreled with the State of Georgia in the 1960’s 

and 1970’s regarding the opinion that water consumption for urban and agriculture uses within 

Georgia had superseded the needs of other water-users and ecosystems to the south and the west.  

In January 1982, in lieu of imminent litigation, a ‘Memorandum of Agreement’ (MOA) was 

signed by the governors of the three states, and the USACE, in which all four parties agreed to 

develop a comprehensive basin-wide water assessment, a navigation maintenance plan, a drought 

management plan, and a water management strategy for the ACF watershed (Leitman et al. 
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1991).  The ACF basin MOA attempted to develop a rational and scientific water management 

policy based on a ‘live and let-live’ principle.  However, after several extensions, the MOA had 

failed to result in a compromise due to insufficient funding, incomplete habitat assessments, 

withholding of information, threats of new litigation, changes in elected officials, and overall 

differences in opinion regarding definitions of reasonable water use (Dellapenna 2004).  In early 

1996, the states of Florida, Georgia, and Alabama revisited the water allocation problems, and 

began drafting an outline to develop an interstate water compact (Carriker 2000).  During their 

1997 legislative sessions, the three states passed the framework program, the governors signed 

the measure, and sent the proposal to Washington D.C. for congressional approval.  The US 

Congress ratified the Apalachicola-Chattahoochee-Flint River Basin Compact (ACFRBC) on 

November 20, 1997, that established an agenda, timeline, and an interstate basin commission, for 

developing an agreement to allocate water from the shared river system (Carriker 2000; Sherk 

2005).  There were many points of contention during the years of negotiations under the 

ACFRBC, but the fundamental disagreement among the parties concerned whether the State of 

Georgia would be responsible for delivering only the minimum flow of water, regardless of 

hydrologic conditions, to the Florida border (Snowden 2005).  It seemed as if a stalemate was 

inevitable; however, on July 22, 2003, after numerous deadline extensions, the states of Florida, 

Georgia, and Alabama signed a ‘Memorandum of Understanding’ that indicated that they had 

reached an ‘agreement in principle’ regarding various terms of a water allocation formula, and 

committed the states to additional negotiations (Sherk 2005).  Unfortunately, little progress was 

made during talks in the months that followed as the states became increasingly unwilling to 

make concessions; therefore, on August 31, 2003, without another extension, the ACFRBC 

terminated (Dellapenna 2004).  The expiration of the ACFRBC officially ended objective 
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dialogue between the states of Florida, Georgia, and Alabama regarding water allocation in the 

ACF basin, and has forced all subsequent decisions to be made within the federal court system. 
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Figure 2-1.  Map of the ACF drainage basin in Florida, Georgia, and Alabama. 
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CHAPTER 3 
CHARACTERIZATION, FLUVIAL EFFECTS, AND SIGNIFICANCE OF SNAGS 

Definition of Snags 

The term ‘snag’ is used in lotic systems to refer to any woody structure, regardless of size, 

that lies within the banks of a watercourse.  Snags are ubiquitous and integral components of 

rivers and streams flowing through forested floodplains.  The importance of snags as a habitat 

component in the ecology of aquatic systems has become increasingly recognized during the last 

30 years (e.g., Bilby and Likens 1980; Wallace and Benke 1984; Bilby and Ward 1991; Beechie 

and Sibley 1997).  Tree trunks, limbs, branches, leaves, seeds, bark, and root wads make up the 

majority of allochthonous input deposited in and along rivers and streams (Hynes 1975; Dolloff 

and Webster 2000).  However, during high water inundation, roots, trunks, and low-hanging 

limbs of living trees can also serve as snag habitat for aquatic dwellers.  In the southeastern US, 

downed woody material can be a result of bank undercutting and erosion, natural tree fall, 

forestry operations, fire, flood, lightning, windthrow, disease, insect infestation, or episodic 

weather events such as tornadoes and hurricanes. 

The majority of existing research concerning the ecology and fluvial effects of aquatic 

woody material has been carried out in the high-gradient rivers and streams flowing through 

timber forests of Australia, as well as those in the US Pacific Northwest (e.g., Anderson and 

Sedell 1979; Naiman and Sedell 1979; Triska and Cromack 1980; Webb and Erskine 2003; 

Woldendorp et al. 2004).  Some of the earliest studies of the subject compared natural 

abundances of wood in undisturbed watersheds with those where wood was deposited as a result 

of timber harvesting (Warren and Olsen 1964; Bilby 1981).  Other studies focused primarily on 

woody material of at least 0.1-m in diameter, known as ‘large woody debris’ (e.g., Keller and 

Swanson 1979; Bisson et al. 1987; Lienkaemper and Swanson 1987; MacDonald and Keller 
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1987).  The term ‘large woody debris’ (LWD) originated in the logging industry, and referred to 

waste products, specifically the larger branches, limbs, and unusable trash logs left at a logging 

site after the profitable stems were removed (Murphy and Koski 1989).  With increased 

recognition of the significance of woody material in fluvial systems, aquatic ecologists have 

recently suggested that the term LWD be abandoned in favor of the term ‘large wood,’ thereby 

eliminating any possible negative connotation associated with the word ‘debris’ (Gregory et al. 

2003). 

Effects of Snags on Energy Flow and Nutrient Cycling 

Ecotones are defined as regions of transition associated with sharp gradients in 

environmental factors or in community composition (Stiling 1999).  Riparian zones such as 

floodplain forests are vital ecotones characterized by high species diversity, and high 

productivity, between terrestrial upland and lowland aquatic ecosystems.  Often depicted in two 

dimensions, it is imperative to consider that riparian zones are three-dimensional, 

biogeochemically open systems in nature; they are laterally connected to upslope terrestrial 

localities, as well as functionally connected longitudinally to upstream aquatic locations (Mitsch 

and Gosselink 2000).  By serving as superior filters, floodplains are functional and valuable 

ecotones within fluvial systems. 

Aquatic snags have a prominent influence on numerous ecosystem processes, including 

energy budgeting, primary and secondary production, as well as nutrient resource cycling and 

exchange.  The pattern of nutrient loading, transport, utilization, and storage on the floodplain is 

critical to the survival of healthy riparian communities (Vannote et al. 1980; Baldwin and 

Mitchell 2000).  This pattern is regulated by the ‘flood pulse’ concept; a periodic flooding of 

fluvial systems that provides a vital ecological interaction between the river channel and its 

floodplain (Junk et al. 1989; Benke 2001).  Organic input is an essential component of the energy 
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budget of aquatic habitats (Benke and Wallace 1990).  The bulk of riverine animal biomass is 

derived from production of organic matter that occurs on the floodplain (Junk et al. 1989).  

During floods, a substantial flux of organic matter and nutrients are flushed off the floodplain 

where they either accumulate behind snags, or are deposited into the main river channel (Elder et 

al. 1988; Benke and Wallace 1990).  Snags further influence the routing of sediments, particulate 

organic matter, and nutrients by creating areas of low shear stress and low water velocity, 

facilitating deposition of suspended materials from the water (Wallerstein 2003).  Seasonal 

flooding also influences soil oxygen levels on the floodplain, whereby transitions from aerobic to 

anaerobic conditions affect rates of organic matter decomposition and nutrient mineralization.  

Floodplains act as nutrient sinks for lateral runoff from uplands, but also serve as nutrient 

transformers for downstream water flows (Mitsch and Gosselink 2000).  By trapping particulate 

organic matter, snags help to retain potential nutrient and energy resources from washing rapidly 

downriver, as well as serve as a long-term source of nutrient loading for the floodplain (Wallace 

and Benke 1984). 

Critical linkages exist between natural flow variations and ecological fitness of fluvial 

systems.  Alterations of the timing, magnitude, and duration of extreme flows in rivers are 

significant, particularly in anthropogenically controlled watersheds (Gibson et al. 2005).  

Artificial adjustments of flow regime have cascading effects on the chemical, physical, and 

biological components of a river.  Lower than normal riverine flows: 1) reduce the wetted 

perimeter of a waterway that decreases riparian habitat availability; 2) alter water-quality 

parameters by reducing dilution effects; and 3) limit connectivity between the river and its 

floodplain (Light et al. 1998).  Increasing flows and rising water levels can be critical biological 

cues for riverine organisms to migrate up- or downstream, or for others to move from habitats in 
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the main river channel to those on the floodplain where food resources and structure are readily 

abundant for reproduction (Ross and Baker 1983; Light et al. 1998; Postel and Richter 2003).  

Variations in peak flow timing and magnitude can disrupt the mobilization of organic matter and 

nutrients from the floodplain, alter the rates of sediment erosion and deposition, and significantly 

influence the migratory and recruitment success of aquatic species (Knighton 1998). 

Geomorphic and Hydraulic Effects of Snags 

Two major factors that govern channel morphology are sediment supply and temporal flow 

variability, both of which can be influenced by the presence or absence of snags.  Due to their 

irregular shapes and sizes, snags can accumulate upon each other and develop into hazards for 

river transportation, as well as accumulate floating litter.  Therefore, snags have been removed 

from rivers for many years in an attempt to create waterways suitable for navigation, as well as 

for aesthetic purposes.  Other justifications employed for the removal of snags from rivers 

include: 1) to eliminate barriers to fish migration; 2) to reduce the risk of downstream bridge 

piling and navigational marker damage; 3) to reduce rates of river bank erosion; and 4) to 

improve flood mitigation efforts (Harmon et al. 1986; Bisson et al. 1987; Gippel et al. 1992, 

Diehl and Bryan 1993).  It was often believed that removal of snags from rivers was a good 

course of action in flood prevention; however, snag removal tends to increases stream velocity, 

decreases riparian vegetation quantity, and increases channel bed scouring and incision that 

promotes bank failure as sediment is carried downstream (Zimmerman et al. 1967; Wilson 1973; 

MacDonald and Keller 1987; Erskine 1994).  Increased bank stability generated by snag material 

is especially important along the outside bank of meander bends where the channel tends to 

migrate laterally (Bisson et al. 1987; Diehl and Bryan 1993).  Conserving the snag material that 

naturally accumulates in the riparian areas of fluvial systems helps to fortify the channel banks, 

trap sediment in natural levees, increase structural complexity and habitat, as well as reduce the 
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mean velocity of water in the channel and on the floodplain during high-water events (Díez et al. 

2001). 

The most conspicuous effects of snags in rivers and streams are physical: wood can 

influence channel shape, sediment storage and erosion rates, and the path of water flow.  

Downed wood on the floodplain that is large enough to be immobile during floods can have a 

significant influence on morphology, geometry, and profile of the floodplain (Braudrick et al. 

1997).  When a log lies parallel to the flow of a floodplain slough, the streambed may be eroded 

in front of the log forming a lateral scour pool.  Snags can divert the mainstream flow of a slough 

from one side of the channel to the other, forming a backwater pool.  Beechie and Sibley (1997) 

found that pool area and pool spacing varied greatly with channel width and slope in streams 

containing snags.  Pools formed by wood on the floodplain provide essential habitat and 

complexity to the entire bionetwork (Bilby 1981; Dolloff 1994; Baillie and Davies 2002).  Pool 

formation is just one of the physical effects that snags can have on fluvial systems. 

Another physical effect of snags in fluvial systems is bank armoring, or flow divergence.  

Snag material can divert stream flow away from a bank, therefore limiting downstream shoreline 

erosion (Gippel 1995; Berg et al. 1998).  Snags can also divert water into a bank, causing bank 

undercutting and stream widening.  Conversely, wood lying alongside and parallel to the bank 

can prevent bank erosion (Cherry and Beschta 1989).  Snags can also shift water flow from one 

side of a channel to the other, divert flow from the main channel to a side channel, or even force 

the creation of alternate channels.  Channel migration can also create point bars of alluvial 

sediments, oxbow lakes, and backwater swamps.  The influence of snags on formation of these 

local hydrologic features is extensive; however, the impact of humans on fluvial systems tends to 
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constrain channel processes and linearizes corridors, while natural hydrology and 

geomorphology tends to create heterogeneity of these habitats. 

Zones of erosion, storage and transport, and deposition are defined along the course of a 

river system based on its geomorphology, hydrology, and physical processes.  Snags can 

influence the deposition patterns of sediments in rivers and on their floodplains.  Water may be 

forced to go around, over, under, or along a snag, resulting in a range of water velocities.  Fine 

sediments such as silts and clays will accumulate where the water velocity is lowest, such as in 

backwater pools, whereas only coarse sediments remain stationary in faster flows.  The presence 

of snags in rivers can reduce the scouring effect of high water flow, and aid in sediment 

deposition (Baillie and Davies 2002).  Rootwads may act as streambank anchors against high 

flows during floods, reducing soil loss to erosion and downstream sedimentation.  In relatively 

low-gradient floodplains, snags can form logjams which can increase the immediate water level 

and inundate large areas that do not normally experience regular flooding.  Often these 

temporary floods deposit considerable amounts of suspended materials (Ward and Aumen 1986).  

Snags are therefore considered an important factor in fluvial sediment deposition. 

Ironically, in many locations around the world substantial amounts of time and money are 

invested in redepositing snags into rivers and streams that were previously cleared (Gore 1985; 

Andrus et al. 1988; Osborne and Koviac 1993).  Determining where snags should be 

reintroduced, how they should be oriented, and the quantities of woody material that should be 

returned vary by watershed (Hrodey and Sutton 2008).  Piégay (2003), Swanson (2003), and 

Reich et al. (2003) propose various frameworks for wood input and redistribution based on 

specific parameters of individual fluvial systems.  The challenge for river managers is to find and 
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establish a reasonable balance between the effects of bank erosion and navigational concerns 

with the ecological benefits of leaving snags in rivers (Hilderbrand et al. 1998). 

Snag Decomposition and Deadhead Logging 

Most stream inhabiting organisms do not feed directly on snags, but the presence or 

absence of these resources can have a significant influence on food availability and the diversity 

of fauna in the ecosystem.  Helfman (2007) indicated that in low-gradient coastal rivers, snags 

are the most biologically rich habitat available, and can produce four times as much prey than 

mud or sand habitats alone.  The ecological link between energy availability and production of 

higher trophic levels has been well documented (e.g., Myers 1977; Benke et al. 1984; Mattraw 

and Elder 1984; Kemp and Boynton 2004; Kiffney and Roni 2007).  Leaves and small twigs that 

fall into the stream are an important food source for microbes, bacteria, and many species of 

aquatic invertebrates (Bilby and Likens 1980).  Large, stable snags trap smaller pieces of wood, 

that in turn, capture leaves and other organic detritus creating nutrient reservoirs on which 

organisms feed (Bilby 1981).  A 1984 study by Wallace and Benke determined that 75% of the 

organic matter stored in a South Carolina stream and floodplain system was directly associated 

with snag material.  Wood on the floodplain located above existing water levels contributes to 

available refugia at higher water levels (Benke et al. 1985).  Logs suspended above the channel 

can be colonized by a variety of plants and animals, creating a lush microcosm above the water 

(Brown 2002).  Eventually, the suspended log will enter the waterway and add to its wood 

supply. 

The methods and rates of dead wood decomposition in terrestrial and aquatic habitats are 

remarkably different.  Decay of dead woody material in terrestrial systems is primarily driven by 

fungi, and rate of decomposition is rapid due to an abundance of available atmospheric oxygen 

(Rayner and Todd 1979; Elder and Cairns 1982; Baker et al. 1983).  In aquatic systems however, 
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decomposition of snags is achieved primarily by single-celled bacteria, namely actinomycetes 

(Aumen et al. 1983), and rate of decomposition is determined by microbial quantity and 

detritivore palatability (Boling et al. 1975; Bilby 2003).  Bacteria and algae living on the surfaces 

of submerged snags form a slimy coating called biofilm, which becomes food for other 

microscopic biota (Robertson et al. 2001).  Biofilms on snags can also beneficially withdraw 

nutrients from water flowing by, helping to regulate potentially harmful algal blooms and 

downstream macrophyte growth, as well as conserve potential energy resources (Tank and 

Webster 1998).  With the exception of the outermost layers of submerged dead wood, the 

dissolved oxygen concentrations throughout the core of a snag are very low; therefore, 

breakdown of its structural components is much slower than in a terrestrial system (e.g., 

Anderson et al. 1978; Whiles and Wallace 1997; Bilby et al. 1999; Spänhoff and Meyer 2004). 

Old-growth longleaf pine and cypress forests were extensively logged throughout the 

southeastern US in the 19th and early 20th centuries to support worldwide demands for lumber.  

Typically, felled timbers would be floated down rivers to coastal sawmills for conversion into 

useable boards.  It is estimated that five to ten percent of the dense heartwood timbers became 

waterlogged and sank on their attempted journey to the mill sites (Dye and Frydenborg 1999).  In 

coastal rivers and streams of the southeastern US where clays, mud, and sand constitute the 

primary bottom sediments, large wood can become partially or entirely buried in anoxic 

conditions, and is therefore increasingly resistant to decay (Mitsch and Gosselink 2000).  These 

submerged ‘deadhead logs’ can remain on the river bottom for hundreds of years, and are 

extremely valuable in the commercial wood-products industry due to their tight grain pattern and 

unique wood colors.  Individual high-grade deadhead logs can fetch three to five thousand US 

dollars apiece, and generate lumber that is upwards of ten times more valuable than conventional 
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wood (Dye and Frydenborg 1999).  The high-end wood produced from old-growth deadhead 

logs are utilized primarily in the furniture, paneling, and flooring industries. 

Removing deadhead logs from rivers has created legal disputes between log salvaging 

operations and environmental groups.  Log salvaging representatives argue that the logged-

timbers were not present in rivers in the first place, and should therefore be removed.  

Environmental and cultural interests assert that deadhead logs have become integral parts of 

rivers over time, and should consequently remain undisturbed.  Management of these non-

renewable submerged resources became increasingly necessary, so several US states prohibited 

underwater deadhead logging operations while environmental studies were conducted to evaluate 

potential physical, chemical, and biological impacts of deadhead log removal.  These studies 

generated contradicting results, and consequently many states have developed an annual fee-

based permitting process to manage log removal quantities, and to monitor impacts of deadhead 

removal while additional research is conducted. 

Influence of Snags on Aquatic Fauna 

The presence of snags increases the quantity and diversity of available habitats for aquatic-

dwelling organisms.  Snags generate effective habitat heterogeneity due to their complex 

structure that in turn provides a variety of nooks and crannies suitable for refuge.  Snags are 

especially important in altered or degraded rivers, as well as in rivers where other more stable 

bottom substrates, such as rock or gravel, are absent. 

Macroinvertebrates such as insects, mollusks, crustaceans, and worms are highly sensitive 

to changes in their environs; therefore, their population levels are often investigated and 

monitored to assess the overall health and biodiversity of aquatic ecosystems.  Due to this, many 

scientific studies have been conducted through the years to examine invertebrate use of snag 

habitat (e.g., Nilsen and Larimore 1973; Anderson et al. 1978; Molles 1982; Benke et al. 1984; 
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Smock et al. 1985; Benke et al. 1985; Thorp et al. 1985; Lemly and Hilderbrand 2000; Braccia 

and Batzer 2001).  Most of these studies have shown that a greater number of individuals and a 

greater diversity of invertebrate species are found in fluvial reaches containing snags in 

comparison to similar reaches without snags.  Aquatic insects utilize snag habitats for feeding 

(whether scraping, grazing, or filtering), resting, predator avoidance, egg deposition, and for 

pupation and emergence (Anderson et al. 1978, Benke et al. 1984; Drury and Kelso 2000).  In a 

lower Coastal Plain river in the southeastern US, Benke et al. (1984) found that the diversity of 

invertebrate taxa on snags was much greater than that of sand or mud; however, snag habitat 

made up only 6% of the available substrate.  Ager et al. (1985) determined that in a southeastern 

US fluvial system, snag habitat had the highest density of macroinvertebrates when compared to 

all other potentially available benthic substrates.  In large sandy bottom rivers, like those found 

in the Coastal Plain of the southeastern US, snags are extremely vital as they provided the only 

stable periphyton habitat for many invertebrates. 

The unionid mussel fauna of the southeastern US was at one time the most species-rich in 

the world, and the ACF basin is considered to be the center of unionid mussel speciation (Brim 

Box and Williams 2000).  However, modern ACF mussel assemblages have experienced an 

abrupt decline, perhaps by as much as 50%, as a result of habitat degradation, pollution, 

impoundment, and introduction of exotic species (Williams et al. 1993; Golladay et al. 2004).  

Chastain et al. (2006) indicated that the Flint River had 76% of its historical mussel species 

remaining, while Brim Box and Williams (2000) reported that only remnant and isolated unionid 

populations remain in the Chattahoochee River.  Of the remaining ACF mussel assemblages, 

64% of the species are categorized as either endangered, threatened, or of special concern (Brim 

Box and Williams 2000).  Unionid reproduction is unique in that it is reliant on specific fish 



 

38 

species to serve as hosts for their specialized larvae; successful mussel reproduction is therefore 

dependent on the spawning and rearing success of these critical fish species.  Freshwater mussels 

are an important component of Coastal Plain fluvial ecosystems as they filter nutrients from the 

water and accumulate potentially harmful chemicals and metals into their bodies and shells (Hart 

and Fuller 1974).  Decreased water flows in the ACF basin leaves unionid mussel populations 

vulnerable to extirpation which could ultimately have impacts on water-quality within the 

watershed. 

An increasing number of studies have been published recently regarding snags as essential 

fish habitat.  Analogous to the structural cover provided by coral reefs in marine ecosystems, 

snags serve as a feeding, spawning, and nursery site for fish in fluvial systems.  Submerged 

snags are especially significant in shifting sandy-bottomed lotic systems, where they provide 

niche variation, velocity refuge, and often the only available stable substrate and cover (Wallace 

and Benke 1984; Braccia and Batzer 2001).  Benke et al. (1984) found that several species of 

game fish foraged exclusively on invertebrates associated with snag material, and Benke et al. 

(1985) reported that major warm-water fishes in a southeastern US Coastal Plain stream obtained 

at least 60% of their prey biomass entirely from snag habitat.  Anglers have historically been the 

greatest advocates for snags in fluvial systems, as they have long recognized that snags serve as 

effective fish aggregation structures (Lobb and Orth 1991).  Ager et al. (1985) indicated that 

river habitat containing snags was found to have twice as many game fish species as similar 

habitats without snags.  Alteration of snag abundance can also influence the distribution of apex 

predators and prey.  Studies by Angermeier and Karr (1984) and Peterson and Bayley (1993) 

determined that the removal of snags from streams altered the predator-prey balance by 

effectively reducing the number of apex predators, and increasing the number of smaller fish 
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species.  In high gradient streams, fish often congregate in dammed plunge pools created by 

snags and large wood as an escape from high water velocities, and as refuge from predators 

(Angermier and Karr 1984).  Reduction in riverine snag quantity and distribution can severely 

limit the quantity of food resources and protective cover available to fish, two essential 

components of healthy fish populations. 

Invertebrates and fish are not the only fauna that use snags as habitat in fluvial systems.  

Snags emerging from a river provide a preferred site for resting, foraging, and roosting for many 

aquatic turtle, snake, and bird species.  Snags on the floodplain can be valuable habitat for 

herpetofauna such as salamanders, skinks, lizards, frogs and toads, as well as for mammalian 

predators such as rat, raccoon, opossum, and armadillo that often forage at floodplain snags sites 

(Means 1977).  Next to humans, the most influential contributor to snag habitat abundance is the 

beaver, whose impoundments and lodges constructed from wood obtained on floodplains can 

significantly alter stream hydrology, and introduce large quantities of snag material into fluvial 

systems (McTaggart and Nelson 2003; Pollock et al. 2003). 
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CHAPTER 4 
NOVEL METHOD FOR QUANTIFICATION OF EXPOSED SNAG MATERIAL IN 

FLUVIAL SYSTEMS USING DIGITAL IMAGING ANALYSIS 

History of Aquatic Snag Quantification 

To assess the potential importance of snags as habitat for aquatic fauna, it is necessary to 

quantify the woody material in lotic systems.  Historically, estimates of snag abundance and 

density in freshwater aquatic systems were generated as a byproduct of other biological or 

hydrologic investigations, and it was not until the late-1970’s that studies began to focus 

specifically on the quantification of aquatic wood (Gippel et al. 1996).  Using methods originated 

in the forestry industry for calculation of residual logging waste, ecologists looked to enhance 

existing techniques for the quantification of aquatic wood (e.g. Anderson et al. 1978; Triska and 

Cromack 1980; Wallace and Benke 1984; Benke and Wallace 1990).  The line intersect 

technique developed by Warren and Olsen (1964) and further modified by Van Wagner (1968), 

Bailey (1970), and de Vries (1974) was a practical method used to estimate the quantity of wood 

lying on or near the ground by simply obtaining the diameters of all woody stems that crossed a 

hypothetical sample line.  Applied to fluvial systems, the line-intersect technique was reasonably 

effective for rapid assessment of large diameter wood exposed along the banks, or submerged in 

clear water, low-order reaches.  In turbid, tannic, or high-order fluvial systems, however, the 

line-intersect technique was not a feasible option for quantification of submerged wood.  In 

addition, the method was found to be significantly inaccurate at estimating quantities of small 

diameter woody material, and did not reveal much information about the distribution of wood 

along the sample transect (Gippel et al. 1996). 

Due to the dynamic nature of fluvial systems, it is difficult to predict rates of wood 

recruitment and depletion over space and time.  In addition to natural variations in river stage 

and downstream snag transport, anthropogenic influences such as forestry operations, and 
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deadhead logging perturb total wood volumes in fluvial systems.  Due to the limitations of the 

line-intersect method for wood quantification in turbid or lengthy river reaches, alternative 

methods such as low-level aerial surveys and side-scanning sonar have been used (Hamilton and 

Bergersen 1984).  Unfortunately, these techniques have substantial drawbacks as well.  Aerial 

surveys of river banks: 1) are generally expensive; 2) tend to be obscured by overhanging 

vegetation; and 3) do not provide an accurate vertical scale for the distribution of snags above the 

waterline (Fitzgerald et al. 2006).  Side-scanning multi-beam sonar can be used to profile 

submerged snags even in turbid water.  However, the technique: 1) is exclusively limited to the 

mapping of underwater material; 2) tends to perform better in deeper water with a uniform 

bottom profile; and 3) is susceptible to failure when the boat-towed sonar transducer becomes 

ensnared in the woody material that it is mapping (Flug et al. 1998). 

In situations where stream flow was a limiting factor in the availability of aquatic habitat 

resources, an incremental methodology called IFIM, and a model dubbed PHABSIM were 

developed in the 1970’s by a collaboration of federal and state agencies to predict changes in 

physical microhabitat associated with modifications in hydraulic flow regime (Bovee 1982, 

1986).  One of the most commonly utilized outputs from the IFIM and the PHABSIM model is 

an ‘index of weighted usable area’ that aids water managers in negotiating low-flow targets and 

assessments of critical habitat availability (Milhaus et al. 1989).  The IFIM and the PHABSIM 

model are challenging to use because they entail multiple pathways and many steps that are 

based on user-level understanding of the problem at hand, and they require integrating existing 

long-term streamflow datasets of flow regimes, surface elevations, and water velocities, which 

are not always available (Milhaus et al. 1984).  In addition, the IFIM and the PHABSIM model 

are limiting because: 1) their final outputs vary due to disparities in user-defined indices of 
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channel characteristics; 2) the methodology and model have several significant assumptions that 

are difficult to overcome; and 3) the methodology and model do not account for critical water-

quality or energy-input components desired in the interest of aquatic ecology (Milhaus 1999). 

Very little research, especially in Florida, has been done to quantify the loss of habitat for 

aquatic fauna when snag material is exposed above water level during low-water conditions.  

Several studies by Ray (1999a-d) discussed the ecological and morphological significance of old 

growth deadhead logs as habitat for macroinvertebrates in several Florida panhandle rivers and 

streams, while a report by Estevez and Sprinkel (2000) examined the distribution and abundance 

of wood in the Santa Fe and lower Suwannee Rivers based on water level fluctuations.  Wood 

quantification techniques used in these surveys were not feasible options for the conditions 

present in the Apalachicola River.  Therefore it became apparent that another method of snag 

habitat quantification would need to be developed, perhaps using digital image analysis. 

Digital image analysis is a computer-based technique used to generate numerical data by 

examining detailed properties of an image.  Many scientific disciplines have turned to digital 

image analysis due to its widespread applicability, ease of use, and low cost.  By utilizing a 

variety of methods and procedures, computers are able to accurately, dependably, and repeatedly 

identify and measure properties of an image that the human eye is unable to quantify.  Historical 

limitations of using digital image analysis were primarily rooted in low image resolutions and 

slow computer processors; however, these restrictions have been surpassed by increasingly 

affordable advances in technology.  In many scientific fields, digital image analysis has 

developed into an ideal method for rapid and inexpensive data analysis. 

Study Design and Methods 

Ager et al. (1987) defined six bank habitat types for the Apalachicola River based on 

steepness of the riverbank, substrate type, and presence of submerged aquatic vegetation.  Steep 
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sloping banks (bank angle greater than or equal to 45° from horizontal), gentle sloping banks 

(bank angle less than 45° from horizontal), and sandbar habitats comprised 92.6% of the 

Apalachicola River banks (41.7%, 27.0%, and 23.9% respectively), while the remaining 7.4% of 

bank habitats were classified as dike fields (2.3%), rock (2.1%), and submerged aquatic 

vegetation (3.0%) (Ager et al. 1987).  Rock habitats were found exclusively in the uppermost 

portion of the Apalachicola River, while submerged aquatic vegetation was found exclusively in 

the tidal reaches of the river. 

Four major reaches in the Apalachicola River were defined by Leitman (1984) based on 

differences in their geomorphic and physiographic characteristics: A) upper reach, B) middle 

reach, C) non-tidal lower reach, and D) tidal lower reach (Figure 4-1).  For this study, an 

intensive study reach of 55.3 km was selected within the middle and non-tidal lower reach 

portions of the Apalachicola River; from just downstream of Estiffanulga Landing (RM 62.4) to 

just upstream of the confluence of the Apalachicola River with the Chipola River (RM 28.1) 

(Figure 4-2).  This particular study reach was chosen based on its incorporation of four (steep 

banks, gentle banks, sandbars, and dike fields) of the six bank habitat types delineated by Ager et 

al. (1987) (Figure 4-3).  Within the study reach, 30 sites were designated equidistantly from each 

other (≈2.0 km by river) using USGS 7.5-minute topographic quadrangle maps (Figure 4-4).  

Specific details regarding the location of the individual study sites are found in Table 4-1.  At 

each of the 30 sites, both the left- and right-descending banks were evaluated for a total of 60 

sampling stations.  Geomorphic and bank habitat classifications of the sampling stations are 

summarized in Table 4-2. 

In the field, a Garmin GPS III Plus™ (ver. 2.06) navigation unit was used to position the 

survey crew at each of the 30 pre-selected river study sites.  Each sampling station consisted of 
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four semi-contiguous 10-m long segments of riverbank.  Every effort was made to have 

concurrent 10-m long segments for photography; however, certain segments were shifted 

upstream slightly (typically no more than 5 m) due to site topography.  A Bushnell Yardage 

Pro® laser rangefinder was used by the boat operator to position a boat 35- to 40-m from the 

shoreline, bow directed upstream, into the current.  From this position on the water, each of the 

10-m segments of shoreline was digitally photographed three to five times in repetition by the 

photographer on the boat.  In each photograph, a vertical reference scale was attained by having 

a field technician stand on the riverbank holding a stadia rod perpendicular to the water surface 

at the point where the bank and water converge.  The stadia rod used for vertical reference was a 

3.5-m x 0.05-m PVC pipe having 0.5-m black and white gradations along its length.  

Photographs were taken of the river shoreline from the existing water level to at least bankfull 

elevation or higher, with the stadia rod held vertically at the downstream end of each 10-m long 

segment (Figure 4-5).  Field notes in regards to specific parameters for each sampling station 

were recorded on custom generated snag abundance datasheets (Appendix A). 

Color photographic images were captured using a Nikon Coolpix® E5600 (ver. 1.0) 

handheld digital camera.  The ‘normal’ imaging mode setting was used, with automatic focus 

and white balance, neutral exposure, single image capture, and standard color, which generated 

photographs with a pixel resolution of 2592 x 1944.  Digital photographs were saved on Secure 

Digital (SD) memory cards in .jpg (24 bit) format.  The file size for each digital image was 

approximately 1.0 MB. 

Digital Photograph Processing and Analysis 

All digital photographs were uploaded from the SD memory cards onto a Microsoft® 

Windows-based desktop computer where they were appropriately labeled and catalogued into a 

photographic database.  For each of the 10-m shoreline segments photographed, a single 
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representative photograph was selected from the three to five images captured in the field.  The 

representative photograph was chosen based on its optimization of the following seven criteria: 

1) image clarity; 2) focus; 3) resolution; 4) brightness; 5) image-shoreline parallelism; 6) 

shoreline-stadia rod perpendicularity; and 7) absence of avian or flying-insect interference. 

Segment photographs were optimized for digital image analysis using Adobe Photoshop 

7.0 (© 2002 Adobe Systems, Inc.) photo editing software.  Original color images (Figure 4-6A), 

were ‘inverted’ to form a photographic negative and then converted to a grayscale format 

consisting of 256 shades of gray (Figure 4-6B).  Grayscale images were reduced in size, and 

saved as uncompressed tagged image files (.tif). 

Calculation of snag area was accomplished using Image J (ver. 1.35s) image processing 

and analysis software.  Image J is a Java-based computer program developed at the US National 

Institutes of Health that runs in most major operating systems and is available free of charge as 

public domain software (Rasband 2002).  By converting individual picture elements (pixels) to a 

unit of measurement, Image J is capable of calculating areas of irregular-shaped objects using 

user-defined scales. 

Each grayscale .tif image file was opened in Image J for digital image analysis.  

Measurement scale was reset for each image by instructing the program to count the number of 

pixels necessary to traverse 1.0 m on the stadia rod (n ≈ 110).  After the scale for a photograph 

was defined, a 10.0-m horizontal line was stretched out digitally along the water surface using 

the ‘line’ and ‘measurement’ tools, and ultimately sketched on the photograph using the ‘draw’ 

command.  Utilizing the ‘box’ tool, a 0.5-m tall x 10.0-m long rectangle block was expanded 

adjacent to the digitally sketched horizontal line, and the vertical stadia rod as a 5.0-m2 

measurement boundary for calculation.  The entire image was then filtered in Image J with a 
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simple thresholding algorithm at a threshold pixel brightness value of 128 to produce a binary 

image suitable for analysis (Ridler and Calvard, 1978) (Figure 4-6C).  The thresholding 

procedure enhanced the snag material from its surroundings by converting all the grayscale 

pixels in the image to either a black or white pixel depending on its grayscale brightness value 

(0-128=black pixel; 129-256=white pixel). 

Within the 5.0-m2 measurement block, Image J counted all of the black pixels using the 

‘analyze particles’ command, and generated an area (m2) value based on the previously defined 

measurement scale.  The measurement block was then moved 0.5 m up the stadia rod using the 

‘hand’ tool, and the measurement process was repeated until all seven of the 5.0-m2 blocks had 

been measured (Figure 4-6D).  Area values generated by Image J were recorded into Microsoft® 

Office Excel (ver. 2003 SP2) spreadsheets for data management and further analyses.  Detailed 

guidelines for digital photograph optimization, processing, and analysis techniques utilized in 

this study are contained in Appendix B. 

Prior to actual data collection on the Apalachicola River, two preliminary studies were 

conducted to assess the repeatability, sensitivity, and logistics of using the proposed digital 

image analysis techniques for snag area quantification.  In the first study, a 0.5-m x 0.5-m 

Plexiglas square was constructed, painted white, and subsequently framed with a 0.025-m wide 

black border as a sample object of known area.  The test square was attached 1.75 m above 

ground level on a vertical pole, with one edge of the square parallel to the ground surface.  A 

100.0-m measuring tape was extended outward from the pole, and survey flags were inserted into 

the ground at 10.0-m increments.  Three un-zoomed photographs of the test square were taken at 

each 10.0-m distance away from the pole.  The test square was then rotated 45° and the 

photographic procedure was repeated.  All photographs were then analyzed using the digital 
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image analysis techniques to determine errors associated with variation in horizontal distance 

and target orientation.  The results of the first pilot study indicated that horizontal distances 

within 80.0-m of the target object produced area values with less than 5.0% error, while 

distances within 50.0-m of the target produced less than 2.0% error.  Orientation of the target 

was found to have no measurable effect on calculated areas using the proposed methods. 

A second pilot study was conducted on the Suwannee River to address logistical details of 

the field-based methods.  During this trial, a field assistant was positioned along the river shore 

with the 3.5-m stadia rod, and photographs were taken at various distances (~15.0-60.0 m) from 

the bank to assess variations in snag detail.  Additionally, 10.0- to 25.0-m lengths of shoreline 

were photographed at a distance of 40.0-m from the bank to evaluate the length of shoreline 

necessary to generate abundant area data within each of the 0.5-m elevations above water level.  

Results of the second study indicated that photography at a distance of 40.0-m from the shore 

generated ample resolution of even the smallest snags along the bank, and 10.0-m lengths of 

shoreline produced sufficient area data for analyses. 
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Table 4-1.  River mile and geocoordinates of field sites located within the 55.3-km intensive 
study reach of the Apalachicola River.  River mile is the approximate distance 
upstream from the mouth of the river determined by USGS topographic maps.  GPS 
positions are based on the WGS 84 datum. 

Field Site Number River Mile Latitude Longitude 
1 62.4 30° 18’ 22.53” N 85° 02’ 59.08” W 
2 61.1 30° 18’ 00.90” N 85° 03’ 25.74” W 
3 59.9 30° 17’ 08.06” N 85° 03’ 25.74” W 
4 58.8 30° 16’ 20.94” N 85° 03’ 41.66” W 
5 57.5 30° 15’ 32.89” N 85° 03’ 42.74” W 
6 56.3 30° 14’ 54.27” N 85° 04’ 19.94” W 
7 55.2 30° 14’ 23.99” N 85° 04’ 46.05” W 
8 54.0 30° 13’ 41.19” N 85° 04’ 57.32” W 
9 52.8 30° 13’ 14.78” N 85° 05’ 25.93” W 
10 51.7 30° 12’ 41.40” N 85° 06’ 03.12” W 
11 50.5 30° 12’ 49.13” N 85° 06’ 40.85” W 
12 49.3 30° 12’ 28.43” N 85° 07’ 11.06” W 
13 48.1 30° 11’ 43.16” N 85° 07’ 19.82” W 
14 46.9 30° 10’ 52.64” N 85° 07’ 57.00” W 
15 45.9 30° 10’ 07.22” N 85° 08’ 23.99” W 
16 44.6 30° 09’ 31.99” N 85° 07’ 54.86” W 
17 43.4 30° 08’ 36.99” N 85° 08’ 14.29” W 
18 42.3 30° 08’ 08.41” N 85° 08’ 16.97” W 
19 41.4 30° 07’ 19.90” N 85° 08’ 39.48” W 
20 40.0 30° 06’ 55.95” N 85° 07’ 51.97” W 
21 38.7 30° 06’ 32.16” N 85° 08’ 20.72” W 
22 37.7 30° 06’ 22.89” N 85° 08’ 51.80” W 
23 36.5 30° 05’ 42.88” N 85° 09’ 08.76” W 
24 35.4 30° 05’ 16.61” N 85° 08’ 20.01” W 
25 34.3 30° 04’ 18.37” N 85° 08’ 18.76” W 
26 33.1 30° 03’ 38.04” N 85° 08’ 11.80” W 
27 31.9 30° 02’ 36.71” N 85° 08’ 09.12” W 
28 30.7 30° 01’ 50.05” N 85° 07’ 20.40” W 
29 29.4 30° 01’ 26.11” N 85° 06’ 26.86” W 
30 28.1 30° 00’ 56.13” N 85° 05’ 37.79” W 
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Table 4-2.  Geomorphic and bank habitat classifications of sampling stations within the 55.3-km 
intensive study reach of the Apalachicola River.  Geomorphic classifications derived 
from USGS topographic maps, and bank habitat classifications based on Ager et al. 
(1987). 

Station 
Number 

Left or Right 
Descending Bank 

Geomorphic 
Classification 

If a Bend, Inner or 
Outer Bank 

Bank Habitat 
Classification 

1A Left Bank Straightaway  Gentle Bank 
1B Right Bank Straightaway  Steep Bank 
2A Left Bank Straightaway  Gentle Bank 
2B Right Bank Straightaway  Gentle Bank 
3A Left Bank Exiting Bend Outer Bank Steep Bank 
3B Right Bank Exiting Bend Inner Bank Gentle Bank 
4A Left Bank Straightaway  Steep Bank 
4B Right Bank Straightaway  Gentle Bank 
5A Left Bank Exiting Bend Outer Bank Steep Bank 
5B Right Bank Exiting Bend Inner Bank Sandbar 
6A Left Bank Bend Apex Outer Bank Gentle Bank 
6B Right Bank Bend Apex Inner Bank Sandbar 
7A Left Bank Exiting Bend Outer Bank Steep Bank 
7B Right Bank Exiting Bend Inner Bank Gentle Bank 
8A Left Bank Exiting Bend Outer Bank Steep Bank 
8B Right Bank Exiting Bend Inner Bank Gentle Bank 
9A Left Bank Bend Apex Outer Bank Steep Bank 
9B Right Bank Bend Apex Inner Bank Sandbar 

10A Left Bank Bend Apex Outer Bank Steep Bank 
10B Right Bank Bend Apex Inner Bank Sandbar 
11A Left Bank Straightaway  Gentle Bank 
11B Right Bank Straightaway  Steep Bank 
12A Left Bank Exiting Bend Inner Bank Sandbar 
12B Right Bank Exiting Bend Outer Bank Steep Bank 
13A Left Bank Straightaway  Gentle Bank 
13B Right Bank Straightaway  Steep Bank 
14A Left Bank Exiting Bend Outer Bank Steep Bank 
14B Right Bank Exiting Bend Inner Bank Sandbar 
15A Right Bank Bend Apex Outer Bank Steep Bank 
15B Left Bank Bend Apex Inner Bank Sandbar 
16A Left Bank Exiting Bend Outer Bank Steep Bank 
16B Right Bank Exiting Bend Inner Bank Sandbar 
17A Left Bank Exiting Bend Inner Bank Sandbar 
17B Right Bank Exiting Bend Outer Bank Steep Bank 
18A Left Bank Exiting Bend Inner Bank Gentle Bank 
18B Right Bank Exiting Bend Outer Bank Steep Bank 
19A Left Bank Exiting Bend Inner Bank Gentle Bank 
19B Right Bank Exiting Bend Outer Bank Steep Bank 
20A Left Bank Bend Apex Outer Bank Steep Bank 
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Table 4-2.  Continued. 
Station 
Number 

Left or Right 
Descending Bank 

Geomorphic 
Classification 

If a Bend, Inner or 
Outer Bank 

Bank Habitat 
Classification 

20B Right Bank Bend Apex Inner Bank Gentle Bank 
21A Left Bank Entering Bend Outer Bank Steep Bank 
21B Right Bank Entering Bend Inner Bank Sandbar 
22A Left Bank Straightaway  Steep Bank 
22B Right Bank Straightaway  Gentle Bank 
23A Left Bank Bend Apex Inner Bank Sandbar 
23B Right Bank Bend Apex Outer Bank Steep Bank 
24A Left Bank Bend Apex Outer Bank Steep Bank 
24B Right Bank Bend Apex Inner Bank Sandbar 
25A Left Bank Bend Apex Inner Bank Gentle Bank 
25B Right Bank Bend Apex Outer Bank Steep Bank 
26A Left Bank Exiting Bend Inner Bank Steep Bank 
26B Right Bank Exiting Bend Outer Bank Dike Field 
27A Left Bank Bend Apex Inner Bank Steep Bank 
27B Right Bank Bend Apex Outer Bank Gentle Bank 
28A Left Bank Straightaway  Gentle Bank 
28B Right Bank Straightaway  Steep Bank 
29A Left Bank Exiting Bend Outer Bank Steep Bank 
29B Right Bank Exiting Bend Inner Bank Gentle Bank 
30A Left Bank Bend Apex Outer Bank Steep Bank 
30B Right Bank Bend Apex Inner Bank Gentle Bank 
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Figure 4-1.  The four major reaches of the Apalachicola River as defined by Leitman (1984).    

A) Upper reach (RM 106.3-77.4).  B) Middle reach (RM 77.4-42.0).  C) Non-tidal 
lower reach (RM 42.0-20.6).  D) Tidal lower reach (RM 20.6-0.0). 
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Figure 4-2.  Map of the Apalachicola River basin and surrounding region.  Large box indicates 

the location of the 55.3-km intensive study reach.  Selected cities are denoted by 
circles, and river gaging stations indicated by squares. 
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A    B 

C    D 
 
Figure 4-3.  Representative photographs of the four bank habitat types defined by Ager et al. (1987) encountered during this study.          

A) Steep sloping bank.  B) Gentle sloping bank.  C) Sandbar.  D) Dike field.  These images not used for analysis purposes. 
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Figure 4-4.  Map of the 55.3-km intensive study reach of the Apalachicola River indicating the 

specific locations of the 30 study sites.  At each study site, both the left- and right-
descending banks were evaluated for a total of 60 sampling stations.
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Figure 4-5.  Example of a digital image captured using the methods detailed in this study.  Note 

the field technician on the riverbank holding the 3.5-m long stadia rod perpendicular 
to the water surface at the location where the bank and water converge. 
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A    B 

C    D 
 
Figure 4-6.  Filtering and processing steps used to prepare photographs for digital image analysis.  A) Original color image.  B) 

Grayscale negative of the original color image.  C) Thresholded black-and-white image.  D) Thresholded image illustrating 
the seven, 0.5-m tall x 10.0-m long superimposed measurement blocks used for digital image analysis. 
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CHAPTER 5 
HYDROLOGIC ANALYSES, RESULTS, AND DISCUSSION 

Hydrologic Analyses 

In order to appraise riverine habitat availability in relation to river stage or discharge, it is 

necessary to understand the hydrology of the basin.  By examining time series data from gaging 

stations, inferences can be made regarding changes in river geomorphology with time, as well as 

the likelihood of experiencing similar hydrologic conditions in the future (McCuen 2005).  For 

this study, real-time hydrologic stage and flow data were available from three USGS surface-

water gaging stations on the Apalachicola River.  Gages were located at Chattahoochee (USGS # 

02358000) (RM 105.8), Blountstown (USGS # 02359170) (RM 77.6), and near Sumatra (USGS 

# 02358700) (RM 20.6) (Figure 4-2).  Data from the Chattahoochee gage were used in this study 

for all long-term flow analyses based on its extensive period of record (1929-present).  All short-

term flow analyses were made from data generated at the Blountstown gage due to its proximity 

to the 55.3-km intensive study area, therefore minimizing lag time effects.  According to Light et 

al. (1998), Apalachicola River flows below 15,000 cfs at the Sumatra gage are generally tidally 

influenced, so data from this gaging station were not utilized in this low-flow study. 

Based on 1929-2006 daily discharge data obtained from the Chattahoochee gaging station, 

a linear mean daily discharge duration curve was constructed to determine the percentage of time 

a given discharge was equaled or exceeded (Figure 5-1).  In order to interpret the likelihood and 

magnitude of extreme flow events, the daily discharge data were transformed to produce a 

logarithmic mean daily discharge plot (Figure 5-2).  Because the State of Florida and the USACE 

use data from the Chattahoochee gage to monitor and regulate water flows in the Apalachicola 

River, and because this study utilized stage and discharge data obtained from the Blountstown 

gage, an equivalency curve approximating the relation of Chattahoochee gage discharge readings 
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with Blountstown gage stage readings for the Apalachicola River was generated (Figure 5-3).  

Additionally, a stage-discharge rating curve (Figure 5-4) and a stage-discharge hydrograph 

(Figure 5-5) were constructed from data obtained at the Blountstown gage spanning the duration 

of this study (March 2004-March 2006). 

Due to the dynamic nature of fluvial systems, and because parameters and units used to 

specify water levels, flows, and elevations can become confounded, a datum designated as 

‘baseline’ was defined in this study to signify the river conditions during data collection.  

Baseline readings at the Blountstown gage were a stage of 4.08 ft, and a discharge of 10,100 cfs.  

Snag quantification for this study was performed at a total of seven, 0.5-m distances above 

baseline.  Table 5-1 contains equivalent stage, discharge, and NGVD 29 sea-level elevations at 

the Blountstown gage for baseline conditions, as well as at each of the 0.5-m distances above 

baseline. 

Results 

From 10-13 October 2005, a total of 1,060 digital photographs were captured of shoreline 

habitat within the 55.3-km intensive study reach of the Apalachicola River.  Within this reach, 

240 digital images totaling 2.4 km of river shoreline were quantified for snag abundance and 

distribution in each of the seven 0.5-m tall x 10.0-m long measurement blocks above baseline, 

using the digital imaging analysis techniques detailed in Chapter 4.  Based on bank habitat 

classifications defined by Ager et al. (1987), nearly all of the 60 sampling stations in this study 

were classified as steep sloping banks, gentle sloping banks, or sandbar habitats; only one dike 

field station was encountered during the survey (Table 5-2).  Most of the sampling stations 

(96.6%) were geomorphically classified using USGS topographic maps as being located at the 

apex of a bend, exiting a river bend, or along a river straightaway, while only 2 stations were 

located at the entrance to a bend in the river (Table 5-3). 
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Visual inspection of the original color images of river banks captured in the field indicated 

that sandbar habitats typically possessed the lowest quantity of available snag material (e.g., 

Figure 4-3C); however, comparison of mean snag area values generated for sandbar habitats 

using the novel methods presented in this study, with those of the three other habitats 

encountered, revealed that sandbar area values were erroneously elevated (Figure 5-6).  Data 

from sandbar habitats were consequently omitted from subsequent analyses due to their 

inaccuracy.  Analysis of mean snag area submerged for non-sandbar habitats indicated that the 

greatest quantities would occur within the first meter above baseline; gentle sloping bank habitat 

having the highest mean area submerged (3.19 m2), followed by steep sloping banks, and dike 

field habitats (2.56 and 1.71 m2, respectively) (Table 5-4; Figure 5-7).  Mean snag area 

submerged for non-sandbar habitats based on geomorphic classification revealed the greatest 

quantities of snags would be submerged at a river stage between 0.5-m to 1.0-m above baseline; 

river banks entering a bend having the highest mean snag area submerged (3.97 m2), followed by 

straightaway, exiting bend, and bend apex locations (2.97, 2.83, and 2.37 m2, respectively) 

(Table 5-5; Figure 5-8).  Further geomorphic analyses of non-sandbar habitats showed that 

within the first 0.5-m above baseline the inner banks of bends in the river have the most snag 

area submerged (3.09 m2), followed the outer banks of river bends that would have a maximum 

mean area submerged of 2.50 m2 at a distance between 0.5-m to 1.0-m above baseline (Table 5-

6; Figure 5-9). 

Examination of the sampling stations subdivided into Ager et al. (1987) habitat 

classifications indicated that 50% of the total available snag material would be submerged at 

0.92 m above baseline for gentle sloping banks, 0.97 m above baseline for dike field habitat, and 

1.32 m above baseline for steep sloping banks (Figure 5-10).  Separating the non-sandbar habitat 
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sampling stations into geomorphic classifications showed that the distance above baseline at 

which 50% of the total available snag material would be submerged at a range from 1.10 m for 

river straightaways, to 1.32 m for sampling stations entering a river bend (Figure 5-11).  

Additional geomorphic evaluation revealed that the distance above baseline at which 50% of the 

available snags would be submerged was 0.94 m for inner banks of river bends, 1.10 m for river 

straightaways, and 1.32 m for outer banks of river bends (Figure 5-12). 

Discussion 

In fluvial systems, hydrologic variability analyses and incremental methodologies are 

useful approaches for determining minimum instream flow requirements needed to maintain 

optimal ecological function and biotic integrity during low flows (Richter et al. 1997).  

Examination of the discharge duration curve (Figure 5-1) indicates that the Apalachicola River 

has experienced a remarkable variation of discharge readings during its 77-year period of record, 

with extreme high and low-discharges recorded on occasion.  Because the curve generated in 

Figure 5-1 covers such a large range of values with many occurring infrequently, the data were 

transformed to produce a logarithmic flow duration plot to assist with interpretation of low-flow 

frequency (Figure 5-2).  The relatively linear shape of the curve in Figure 5-2 indicates that the 

Apalachicola River has a strong baseflow component that can be attributed to both the immense 

size of the upstream Chattahoochee and Flint drainage basins, as well as to the significant 

groundwater influence within the basin (Elder et al. 1988).  Mean daily discharge for the period 

of record at the Chattahoochee gage equaled or exceeded 15,900 cfs 50% of the time, while 

discharges of 8,480 cfs and 5,000 cfs were equaled or exceeded 90 and 99% of the time, 

respectively (Figure 5-2).  Based on these curves, it appears that low-flow conditions in the 

Apalachicola River are not a frequent occurrence.  However, the long period of record at the 

Chattahoochee gage includes 25 years of pre-impoundment, non-regulated discharge data that 
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tends to amplify daily discharge means (Leitman et al. 1983).  Additionally, increased 

consumption of water in the ACF basin in response to growing urbanization and agricultural 

demands, as well as increased rates of evapotranspiration due to river impoundment have 

decreased downstream river flows (Elder et al. 1988).  Light et al. (2006) reported that recent 

discharge reductions in the Apalachicola River have been exacerbated by anthropogenic 

activities along with natural climatic change throughout the ACF basin. 

The equivalency curve in Figure 5-3 indicates that a Blountstown gage stage of 4.08 ft 

(baseline in this study) is generated by a discharge of 10,200 cfs at the Chattahoochee gage.  

Other key Blountstown stage values are 5.72 ft and 7.36 ft (0.5 and 1.0 m above baseline, 

respectively), which correspond to a Chattahoochee discharge of 13,100 and 16,400 cfs, 

respectively (Figure 5-3).  The shape of the stage-discharge rating curve for the Blountstown 

gage (Figure 5-4) indicates that at low flows, the river is confined primarily to its main channel; 

a small change in discharge results in a fairly substantial change in river stage.  The curve also 

illustrates the distributional effects of the expansive Apalachicola River floodplain, in that once 

the river exceeds flood stage, large increases in discharge must be attained to notice appreciable 

changes in river stage (Figure 5-4). 

The digital imaging analysis methods for snag quantification that are presented in this 

study are best suited for extremely low-flow conditions.  Exposed snag material along the banks 

of the Apalachicola River was to be photographed at the lowest water levels possible; ideally at 

or near the State of Florida mandated minimum flow of 5,000 cfs at the Chattahoochee gage.  

Photography was scheduled to take place the first week of September 2004, as the summer had 

been reasonably dry, and water levels in the river were steadily declining towards the state 

minimum (Figure 5-5).  However, the untimely arrival of Hurricane Frances to the Florida 
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panhandle curtailed these plans.  To complicate things further, Hurricanes Ivan and Jeanne 

followed several weeks later, which elevated water levels above flood stage, and eliminated low-

flow photographic opportunities until September of the following year.  With yearly tropical 

cyclone activity highly unpredictable, and having a limited timeframe for data collection, 

photography for this study transpired in mid-October 2005 at relatively low flows (Figure 5-5). 

In an attempt to reduce the introduction of additional error and complexity to the digital 

imaging analysis methods, all photographs were filtered, processed, and analyzed in exactly the 

same manner.  However, a major limitation of using the analysis techniques as described in 

Chapter 4 was revealed for sandbar habitats when comparing the computed mean snag area 

values with the original color images captured in the field.  Nearly all photographs of sandbar 

habitats on the Apalachicola River resembled the image in Figure 4-3C; large aggregations of 

river sand with an occasional interspersed woody snag.  Mean snag area values generated for 

sandbar habitats were erroneously elevated, particularly in the lowest intervals above baseline 

(Figure 5-6).  Visual examination of the original color photographs revealed that images of 

generally shaded habitats types such as steep sloping banks, gentle sloping banks, and dike fields 

normally presented lightly-colored snag material against relatively darker backgrounds (e.g., 

Figure 4-5).  Conversely, images captured of sandbar habitats typically contained darker-colored 

snag material against a nearly white sandy background.  It was also determined that wet, and 

consequently darker-colored sand in the measurement intervals nearest to the water level for 

sandbar habitats were inaccurately interpreted by the analysis methods as snag material.  Similar 

setbacks were not evident for snag areas computed of steep sloping banks, gentle sloping banks, 

or dike field habitats which were usually shaded from direct sunlight.  Another drawback that 

was encountered exclusively at sandbar habitat stations was a depth-of-field problem created by 
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the low-gradient bank angle that often produced a considerable distance between the stadia rod 

and the river bank in the background of the image.  Unfortunately, the limitations of the analysis 

methods for sandbar habitats were not discovered during the pilot study on the Suwannee River, 

as only steep and gentle sloping banks were photographed in that trial.  Potential modifications 

of the methods to reduce errors produced for sandbar habitats include: 1) an adjustment of the 

white-balance, or exposure settings of the camera when images of sandbar habitat are captured in 

the field; 2) use of an alternative threshold value other than 128 in the image processing steps; or 

3) the development of an image processing algorithm that further isolates snag material from its 

surroundings by incorporation of ambient light levels with image contrast ratios.  With visual 

inspections of original color photographs indicating nominal snag quantities on sandbar habitats, 

and due to the considerable quantification error revealed using the existing imaging analysis 

methods, mean snag area data from the 12 sandbar stations examined in this study were omitted 

from all subsequent analyses. 

Mean area of snags submerged for steep sloping bank habitat appears to diminish fairly 

evenly from baseline to the 3.5-m distance above baseline, whereas snag area for gentle sloping 

banks was greatest from baseline to 1.0 m above baseline, then quickly tapered off (Figure 5-7).  

Diehl and Bryan (1993) indicated that steep sloping banks generally occur along the outside 

banks of river bends where erosion rates are fairly high.  As the steep river banks are incised and 

undercut, snag material from the top of the bank tends to fall towards the river where it will often 

hang by its rootwad, or by a network of vines, until it ultimately becomes detached from the 

bank and deposited in the river (Golladay and Battle 2006).  Gentle sloping banks stations on the 

Apalachicola River were for the most part located along the inner banks of a bend in the river, or 

along straightaways of the river (Table 4-2).  Water velocities tend to be lower at these locations 
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and consequently snags have a propensity to be deposited during decreased flows conditions.  

Additionally, Figure 5-7 indicates that when discharge and river stage increase, snags are picked 

up and transported by the increased water velocity, leaving the upper elevations of gentle sloping 

bank habitats without appreciable snag quantities.  Dike field habitat was only represented in this 

study at one sampling station within the 55.3-km intensive study reach (Table 5-2), therefore the 

curve generated by these data was plotted for reference only, and further interpretation was 

reserved (Figure 5-7). 

The entering bend geomorphic classification was also weakly represented in this study 

with a total of two sampling stations (Table 5-3).  Only one of the two entering bend geomorphic 

stations was a non-sandbar habitat type, therefore, these data were plotted as a reference and 

interpretations should be made with caution (Figure 5-8).  Analyses of the other curves within 

Figure 5-8 indicates that geomorphic classification of non-sandbar bank habitat type had 

relatively little influence on mean area of snags submerged, as well as vertical distribution within 

the 3.5-m distance above baseline.  The majority of snags that would be submerged at greater 

river flows are found in the elevations just above baseline conditions, and steadily decreases as 

river stages approach flood stage levels (Figure 5-8).  This trend would be expected as the main 

river channel is the usual collection site, and downstream transport vehicle for products washed 

off the floodplain (Ward et al. 1999).  In addition, river velocities tend to decrease as stage 

decreases, so snags that would ordinarily be transported downriver during high-flow conditions 

end up being deposited along the river banks at lower river velocities (Gurnell 2003).  

Throughout the bends and straightaways of the Apalachicola River, snags quantities appear to be 

encountered fairly homogeneously. 
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Figure 5-9 illustrates that snag distribution along the outer banks of a river bend are 

somewhat more evenly distributed throughout the range from baseline to 3.5 m above baseline 

than along river straightaways, or along the inner banks of river bends.  As the majority of outer 

bank river bend sampling stations were also classified as steep sloping habitats (Table 4-2), the 

increased rates of erosion and bank failure observed at these locations contributes to the slightly 

more even distribution of snag material.  At both inner bank and river straightaway stations, the 

distribution of snag material is greater in the first 1.5-m elevations above baseline, and then 

rapidly diminishes at higher elevations (Figure 5-9). 

Interpretation of the curves in Figures 5-6 through 5-9 should not be extrapolated beyond 

the axes on which they are plotted.  The abundance and distribution of snag material below 

baseline conditions remains undetermined, and it should not be assumed that the existing trends 

would hold true at distances other than what are presented.  Since this was a low-flow study, all 

snag material below baseline conditions was presumed to remain submerged at baseline 

discharges or greater. 

Assuming that all quantified snags would be submerged at the 3.5-m distance above 

baseline, a relative percentage of total available snags was computed for each 0.5-m distance 

above baseline.  In order to compare these curves, the distance above baseline where 50% of the 

available snags would be submerged was arbitrarily selected as a point of evaluation, in addition 

to the general shape of the curve.  Analyses of the plots illustrating the relative percentage of 

snags submerged based on bank habitat classifications (Figure 5-10), geomorphic classifications 

(Figure 5-11), and by bank location within a river bend (Figure 5-12) exhibited results similar to 

those of the area submerged plots: 1) steep sloping banks exhibited the most uniform vertical 

snag distribution, while gentle sloping banks tended to have greater snag quantity at lower 
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distances above baseline; 2) geomorphic classification had no considerable effect on snag 

distribution; and 3) outer banks of river bends tended to have a more balanced distribution of 

available snags throughout the range of measurement than did inner banks of river bends or 

straightaways. 

Recommendations 

Officials responsible for making water allocation choices should continue to rely on 

scientific research to assist with their decisions.  Based on the results of this study, and those of 

scientists from other agencies, the State of Florida should continue to pursue increased river 

discharges from the Jim Woodruff Lock and Dam.  As water levels decline in the river, so does 

the availability of valuable snag habitat which can have cascading negative effects on vital 

physical, chemical, and biological components of the ecology within the Apalachicola River and 

Bay ecosystems. 

The water allocation issues that have developed within the ACF watershed are truly 

complex.  Development of a water management plan for the basin which satisfies human 

consumptive demands while maintaining optimal ecosystem integrity and functionality is a 

difficult task, especially for a basin of its size.  Intuitively, humans prefer to fix problems at the 

local level so immediate results can be achieved (Sparks 1995).  However, in large watersheds 

like the ACF, a system-level approach should be encouraged for increased equity of success.  

Based on the increasing number of stakeholders with interests for water in the basin, there 

appears to be no feasible way to completely satisfy all of its users during unseasonably dry 

periods.  With urbanization and agricultural growth continuing at a rapid pace, the inability to 

meet future water demands will most likely occur with increased frequency.  Water conservation 

efforts among all users in the basin must continue to be endorsed, and rates of urban growth need 

to be checked.  The effects of urbanization greatly exceed the delineated boundaries of urban 
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areas.  With this in mind, it is imperative that local, state, and federal officials remain committed 

to seeking common sense solutions towards an effective balance between the competing water 

demands and conservation needs of river-impacted flora and fauna within the ACF basin. 
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Table 5-1.  Equivalent stage, discharge, and elevation readings at baseline conditions, and at 0.5-
m distances above baseline, for the Blountstown gage, Apalachicola River. 

Distance Above 
Baseline (m) 

Blountstown 
Stage (ft) 

Blountstown 
Discharge (cfs) 

Blountstown 
Discharge (cms) 

Distance Above 
NGVD29 (m) 

3.5 15.56 39,700 1,124.6 12.96 
3.0 13.92 33,400 946.2 12.46 
2.5 12.28 28,300 801.7 11.96 
2.0 10.64 23,700 671.4 11.46 
1.5 9.00 19,600 555.2 10.96 
1.0 7.36 16,000 453.3 10.46 
0.5 5.72 12,900 365.6 9.96 

Baseline 4.08 10,100 286.0 9.46 
 
 
Table 5-2.  Bank habitat classification summary for the 60 sampling stations within the 55.3-km 

intensive study reach of the Apalachicola River.  Habitat classifications based on 
Ager et al. (1987). 

Habitat Classification Number of Stations % of Total Study Area 
Steep Sloping Bank 29 48.3 
Gentle Sloping Bank 18 30.0 

Sandbar 12 20.0 
Dike Field 1 1.7 

 
 
Table 5-3.  Geomorphic classification summary for the 60 sampling stations within the 55.3-km 

intensive study reach of the Apalachicola River.  Geomorphic classifications derived 
from USGS topographic maps. 

Geomorphic Classification Number of Stations % of Total Study Area 
Bend Apex 20 33.3 

Exiting Bend 24 40.0 
Straightaway 14 23.3 

Entering Bend 2 3.4 
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Table 5-4.  Bank habitat classification effects on mean area of snags submerged, and relative percentage of total snag area submerged, 
for non-sandbar habitat stations on the Apalachicola River.  Snag areas submerged at 0.5-m distances above baseline are 
per 10.0-m of shoreline, and percentages are relative to all snags being submerged at 3.5-m above baseline.  Bank habitat 
classifications based on Ager et al. (1987). 

Steep Sloping Bank (n=29) Gentle Sloping Bank (n=18) Dike Field (n=1) 
Distance Above 

Baseline (m) Snag Area 
(m2) Relative % Snag Area 

(m2) Relative % Snag Area 
(m2) Relative % 

3.5 0.99 100.0 0.71 100.0 0.62 100.0 
3.0 1.12 90.7 0.67 93.1 0.47 91.6 
2.5 1.40 81.3 0.63 86.9 0.47 85.9 
2.0 1.78 70.0 1.11 81.3 0.73 79.9 
1.5 2.28 56.4 2.36 72.1 1.35 70.0 
1.0 2.56 38.5 3.14 53.7 1.61 51.8 
0.5 2.29 18.0 3.19 28.1 1.71 28.3 

 
 
Table 5-5.  Geomorphic classification effects on mean area of snags submerged, and relative percentage of total snag area submerged, 

for non-sandbar habitat stations on the Apalachicola River.  Snag areas submerged at 0.5-m distances above baseline are 
per 10.0-m of shoreline, and percentages are relative to all snags being submerged at 3.5-m above baseline.  Geomorphic 
classifications derived from USGS topographic maps. 

Bend Apex (n=14) Exiting Bend (n=19) Straightaway (n=14) Entering Bend (n=1) Distance 
Above 

Baseline (m) 
Snag Area 

(m2) Relative % Snag Area 
(m2) Relative % Snag Area 

(m2) Relative % Snag Area 
(m2) Relative % 

3.5 0.88 100.0 0.76 100.0 0.99 100.0 1.47 100.0 
3.0 0.94 91.5 0.86 92.2 1.00 91.0 1.70 92.5 
2.5 1.15 83.1 1.00 84.5 1.06 82.5 2.43 83.7 
2.0 1.50 72.9 1.56 76.0 1.32 74.0 3.03 71.4 
1.5 2.05 60.0 2.39 63.8 2.29 63.8 3.60 56.3 
1.0 2.37 41.7 2.83 45.4 2.97 46.4 3.97 38.4 
0.5 2.29 20.6 2.61 22.4 2.86 23.1 3.72 18.6 
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Table 5-6.  Effects of bank location within a river bend on mean area of snags submerged, and 
relative percentage of total snag area submerged, for non-sandbar habitat stations on 
the Apalachicola River.  Snag areas submerged at 0.5-m distances above baseline are 
per 10.0-m of shoreline, and percentages are relative to all snags being submerged at 
3.5-m above baseline.  Bank locations derived from USGS topographic maps. 

Inner Bank (n=11) Outer Bank (n=23) Distance Above 
Baseline (m) Snag Area (m2) Relative % Snag Area (m2) Relative % 

3.5 0.62 100.0 0.94 100.0 
3.0 0.60 93.7 1.06 91.1 
2.5 0.56 87.8 1.37 82.0 
2.0 1.19 82.6 1.77 70.8 
1.5 2.44 72.3 2.21 57.1 
1.0 3.04 53.1 2.50 39.2 
0.5 3.09 28.0 2.23 18.5 
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Figure 5-1.  Linear mean daily discharge duration curve for the Apalachicola River at the Chattahoochee gage (1929-2006). 
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Figure 5-2.  Logarithmic mean daily discharge duration curve for the Apalachicola River at the Chattahoochee gage (1929-2006). 
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Figure 5-3.  Equivalency curve approximating the relation of Chattahoochee gage discharge readings with Blountstown gage stage 

readings for the Apalachicola River.  Curve based on unpublished data supplied by H. Light, USGS Tallahassee, 2002.



 

74 

0.0

5.0

10.0

15.0

20.0

25.0

30.0

0

20
,0

00

40
,0

00

60
,0

00

80
,0

00

10
0,

00
0

12
0,

00
0

14
0,

00
0

16
0,

00
0

18
0,

00
0

20
0,

00
0

Discharge (cfs)

St
ag

e 
(ft

)

FLOOD STAGE

  
 
Figure 5-4.  Stage-discharge rating curve for the Apalachicola River at the Blountstown gage (March 2004-March 2006).
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Figure 5-5.  Stage-discharge hydrograph for the Apalachicola River at the Blountstown gage (March 2004-March 2006).  Shaded box 

indicates the period of time when fieldwork was conducted.
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Figure 5-6.  Bank habitat classification effects on mean area of snags submerged at 0.5-m distances above baseline.  Curves generated 

from all data collected within the 55.3-km intensive study reach of the Apalachicola River.  Snag areas submerged at 0.5-m 
distances above baseline are per 10.0-m of shoreline.  Sandbar habitat data are inaccurate, and plotted with a dashed-line as 
a reference only.  Data from these curves should not be extrapolated.
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Figure 5-7.  Non-sandbar bank habitat classification effects on mean area of snags submerged at 0.5-m distances above baseline.  

Curves generated from data collected within the 55.3-km intensive study reach of the Apalachicola River.  Snag areas 
submerged at 0.5-m distances above baseline are per 10.0-m of shoreline.  Data from these curves should not be 
extrapolated.
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Figure 5-8.  Geomorphic classification effects on mean area of snags submerged at 0.5-m distances above baseline.  Curves generated 

from non-sandbar habitat data collected within the 55.3-km intensive study reach of the Apalachicola River.  Snag areas 
submerged at 0.5-m distances above baseline are per 10.0-m of shoreline.  Data from these curves should not be 
extrapolated.
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Figure 5-9.  Effects of bank location within a river bend on mean area of snags submerged at 0.5-m distances above baseline.  Curves 

generated from non-sandbar habitat data collected within the 55.3-km intensive study reach of the Apalachicola River.  
Snag areas submerged at 0.5-m distances above baseline are per 10.0-m of shoreline.  Data from these curves should not be 
extrapolated.
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Figure 5-10.  Bank habitat classification effects on percentage of total available snags submerged in relation to distance above 

baseline.  Curves generated from non-sandbar habitat data collected within the 55.3-km intensive study reach of the 
Apalachicola River.  Dotted lines correspond to the location where 50% of the total available snag material would be 
submerged.
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Figure 5-11.  Geomorphic classification effects on percentage of total available snags submerged in relation to distance above 

baseline.  Curves generated from non-sandbar habitat data collected within the 55.3-km intensive study reach of the 
Apalachicola River.  Dotted lines correspond to the location where 50% of the total available snag material would be 
submerged.
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Figure 5-12.  Effects of bank location within a river bend on percentage of total available snags submerged in relation to distance 

above baseline.  Curves generated from non-sandbar habitat data collected within the 55.3-km intensive study reach of the 
Apalachicola River.  Dotted lines correspond to the location where 50% of the total available snag material would be 
submerged.



 

83 

APPENDIX A 
SAMPLING STATION FIELD DATASHEET 
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APPENDIX B 
GUIDELINES FOR IMAGE OPTIMIZATION, PROCESSING, AND ANALYSIS OF 

DIGITAL PHOTOGRAPHS 

ADOBE PHOTOSHOP: 

1. File ► Open ► (filename.jpg) [CTRL + ‘O’] 
-‘Discard the embedded profile (don’t color manage)’ 

2. Image ► Adjustments ► Invert [CTRL + ‘I’] 
3. Image ► Mode ► Grayscale 
4. Image ► Image Size ► Pixel Dimensions 

-Width: ‘55’ / ‘Percent’ 
5. File ► Save As ► (filename.tif) [CTRL + SHIFT + ‘S’] 

-‘No image compression’ 
IMAGE J: 

1. File ► Open (filename.tif) [CTRL + ‘O’] 
2. Adjust window size as needed 
3. Select the magnifying glass tool and magnify the stadia rod to the height of the screen 

-[mouse click = Zoom In;  CTRL+ mouse click = Zoom Out] 
4. Select the line tool and stretch a vertical line the length of the stadia rod 
5. Analyze ► Set Scale 

-Enter known distance (3.5) and unit of length (meter); check box ‘global’ 
6. Zoom back out to 100% using magnifying glass tool 

-[mouse click = Zoom In;  CTRL+ mouse click = Zoom Out] 
7. Select the line tool and stretch a 10-m horizontal line along the waterline 

-[CTRL + ‘M’] to measure the line 
-Add or subtract length to the stretched out horizontal line using either of the 

boxes on the ends of the line 
-[CTRL + ‘M’] and adjust repeatedly until a 10-m length is achieved 

8. On the stretched out horizontal line, grab the center box located at 5 m, and drag the 
whole line to the bottom of the stadia rod where the water and shoreline 
meet to create a right angle 

-[CTRL + ‘D’] to draw to line on the image at the waterline 
9. Analyze ► Clear Results 

-‘Do not save’ 
10. Select the magnifying glass tool and magnify the non-stadia rod end of the drawn-in line 

-[mouse click = Zoom In;  CTRL+ mouse click = Zoom Out] 
11. Using the line tool, stretch a vertical line upwards of at least 3.5-m length from the end of 

the drawn-in line 
-[CTRL + ‘M’] to measure the line 
-If the length is 3.5-m or longer, continue on; if the length is short, use the 

uppermost box of the vertical line to add length and measure again; when 
at least 3.5-m is achieved, continue on 

-[CTRL + ‘D’] to draw the vertical line on the image 
12. Select the magnifying glass tool and magnify the stadia rod to the height of the screen 

-[mouse click = Zoom In;  CTRL+ mouse click = Zoom Out] 
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13. Select the rectangle tool and using the stadia rod as a vertical guide, stretch a 0.5-m tall 
rectangle of any length 

14. Use the hand tool, select the center box on each of the vertical edges of the rectangle and 
extend the rectangle to fit between the stadia rod and the drawn-in vertical 
line, which will create a rectangle with dimensions of 10-m x 0.5-m. 

15. With the hand tool, use click and drag techniques anywhere within the rectangle to move 
it to the lowermost 0.5-m interval above the drawn-in horizontal line 

16. Image ► Adjust ► Threshold [CTRL + SHIFT + ‘T’] 
-‘Set’ range from ‘0’ to ‘128’; and ‘Black and White’ 

17. Analyze ► Analyze Particles 
-Use the following settings: ‘1’ / ‘999999’ / ‘2’ / ‘Nothing’; and check the following 

boxes: ‘Display Results’ and ‘Summarize’ 
18. In a spreadsheet program, record the total area value from the Summary window 
19. Close the Summary window 
20. Select ‘Reset’ on the Threshold window 
21. Select the rectangle tool and click in the existing rectangle.  Using the drawn in vertical 

line and stadia rod as guides, slide the rectangle up 0.5 m 
22. Select ‘Set’ on the Threshold window and set range to ‘0’ to ‘128’; and ‘Black and 

White’ 
23. Analyze ► Analyze Particles 

-Use the following settings: ‘1’ / ‘999999’ / ‘2’ / ‘Nothing’; and check the following 
boxes: ‘Display Results’ and ‘Summarize’ 

24. Repeat steps18 through 23 until all seven of the 10-m x 0.5-m sections are measured 
25. In the Results window, select File ► Save As ► (filename.xls) 
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